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1. Vorbemerkungen 

 Nur eingewiesene Nutzer*innen dürfen am TEM arbeiten.  

 Diese Kurzanleitung ist für eingewiesen Nutzer*innen als Schnellreferenz gedacht. Mit F1 erhält 
man am TEM-Rechner die Online Help. 

 Die Hinweise zur Arbeitssicherheit müssen bestens bekannt sein.  

 Bitte kein Essen oder Trinken am TEM (im Vorraum ist es ok).  

 Wenn man den TEM-Raum verlassen will, müssen immer die Column Valves geschlossen sein.       

 Die Session muss gebucht sein und die Kostenübernahme durch das Institut/die Arbeitsgruppe 
muss vorher geklärt sein. (220 Euro pro Sitzung, ggf. zzgl. Probenpräparation)  

 Die Hinweise zu Publikationen müssen bekannt sein und befolgt werden. Nutzungsordnung: „Bei 
Nutzung des TEM verpflichten sich die Nutzer*innen, dem LNQE in Publikationen zu danken.“  

 Dinge, die man am TEM am schnellsten durch Fehlbedienung beschädigen kann: 

  Den Halter verbiegen – Deshalb den Halter immer vorsichtig und niemals mit Kraft be-
handeln. 

  Vakuumeinbruch an der FEG – Deshalb Column Valves immer geschlossen halten, wenn 
irgendwas am Vakuum-System geändert wird.  

 Rotes Licht an der Compustage bedeutet: Niemals einen Probenhalter in die Compustage 
ein- oder ausbauen.  

 Szintillator an der Kamera durch zu viel Strahlleistung beschädigen – Deshalb doppelt 
prüfen, ob der Schirm geschlossen ist, wenn in Diffraction Mode gewechselt wird.     

 

2. Arbeitssicherheit 

 Röntgenschutz: Die Ersteinweisung für Geräte des LNQE, die dem Strahlen- oder Röntgenschutz unter-
liegen, erfolgt durch den Technischen Leiter. Danach muss die Unterweisung spätestens auf den Tag 
genau aufgefrischt werden. Diese Unterweisungen sind dann Online möglich.  

 Flüssiger Stickstoff LN2: Einweisung durch Fritz Schulze-Wischeler. Die Gefahren sind: Kälteverbren-
nungen, Sauerstoffmangel durch Verdrängung, Explosionsgefahr für geschlossene Behälter, O2-An-
sammlung an kalten Oberflächen. => Schützende Cryo-Handschuhe und Schutzbrille tragen beim Um-
füllen.      

 SF6: Im TEM an der FEG und im Technikraum befindet sich SF6. SF6 hat zwei Gefahren:    

 Erstickungsgefahr: Bei Austritt verdrängt es den Sauerstoff und es besteht Erstickungsgefahr 
(SF6 ist schwerer als Luft).  

 Fluor-Vergiftung: SF6 zersetzt sich zu Schwefel und Fluor bei über 250 °C und gibt dadurch 
hochreaktives Fluor frei. Fluor ist sehr giftig.    

 Im Notfall: Im Falle eines Brandes oder einer anderen Notsituation (Gebäudeevakuierung), drücken 
Sie die OFF-Taste auf dem System-On/Off-Panel. Das Mikroskop wird heruntergefahren und damit 
eine Gefährdung von Personen in ihrer Umgebung oder sich selbst minimiert. Schalten Sie den TEM-PC 
aus. Verlassen Sie sofort den Raum mit dem Mikroskop. 
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TEM Bright Field 

3. Starten der Session 

 Überprüfen, ob die Schalter HT und Vac am Control Panel leuchten.  
Dies geht nur, wenn das Raumlicht an ist. Falls nicht beide Kontrolllampen leuchten, dann nicht 
weitermachen, sondern den Gerätebeauftragten kontaktieren.  

 
 

 Am Rechner im Vorraum einloggen und das Anlagen-Buch kontrollieren 
Einloggen in die LNQE-Domäne. Im Gruppenlaufwerk „TEM“ liegt im Hauptverzeichnis das Anla-
gen-Buch „Anlagenbuch TEM FEI Tecnai F20.XLS“. Hier prüfen (insbesondere die Spalte „Besonde-
res“), in welchem Zustand sich das TEM zurzeit befindet. 
  
 

 Am TEM-Rechner einloggen und Steuerprogramme starten 
1. Einloggen mit dem individuellen Benutzer*innen-Namen 
2. Programme starten (in dieser Reihenfolge): 

1. TEM User interface 
2. Digital Micrograph (Etwas warten, bis die Menüs geladen wurden) 
3. TIA  

 Überprüfen, ob „Column Valves“ closed (geschlossen), HT und FEG an sind.  
 

 
 

 
 

Reiter „Setup“ selektieren 

 Status: COL. VALVES  muss ROT sein 

 Col. Valves Closed  muss GELB sein 

 High Tension sollte immer GELB sein 
(d. h. Hochspannung immer an sein) 
und auf 200 kV eingestellt sein. 
 
Wenn HT ausgefallen ist: den Geräte-
beauftragten kontaktieren!!! 

Die FEG sollte immer durchlaufen und 
daher Operate immer GELB sein 
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 Wichtige Werte in das Anlagenbuch übertragen. 

 
 
 

 Blenden/Apertures überprüfen  
C2 auf 4 für TEM, Objective & Selected Area Blende raus 
 

 
 
 
 
 
 
 
 

 Compustage überprüfen 
Die Compustage muss in der Nullstellung sein, d. h. X, Y, Z und α, ß müssen alle etwa 0 sein.  
Wenn das nicht erfüllt ist, dann muss ein Holder-Reset durchgeführt werden (siehe unter „Been-
den der Session“).   

 

Condenser Aperture 1 (C1, immer auf Position 4) 

Condenser Aperture 2 (C2 immer auf Position 3) 

Objective Aperture  

Selected Area Aperture 

Blende ist: 
 

Drinnen 
 

Draußen 

Die Vakuum-Werte in das Anlagenbuch 
schreiben.  

Den FEG Emissions-Strom in das Anla-
genbuch schreiben. Wenn der Strom sich 
deutlich zur letzten Sitzung verändert 
hat, den Gerätebeauftragten kontaktie-
ren.       
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 Flüssigen Stickstoff füllen 
1. Den Sichtschirm am TEM mit der Gummi-Abdeckung abdecken. 
2. Schutzbrille und Schutzhandschuhe anlegen. 
3. Kühlfalle am TEM vorsichtig befüllen bis ca. 1 cm unter den Rand.  
4. Nach ca. 10 Minuten kann eingeschleust werden.  

 
 

 Vakuum Übersicht öffnen 
(Am rechten, unteren Bildschirmrand) 
 
 
 
 

 
 

 
 

Die verschiedenen Werte repräsentieren logarithmische Werte von Drücken.  
 
IGP = Ionengetterpumpe 
Pen = Penning-Vakuummeter 
Pir = Pirani Vakuummeter 

Hier die Vakuum-Übersicht öffnen. 

IGP2 und IGP3 sind das 
FEG-Vakuum (IGP2 muss 1 
sein) 

IGP1 ist das Column-Va-
kuum (muss 6 sein, wenn 
ideal abgepumpt) 

V7 + V4 geschlossen ent-
sprechen dem Zustand „Co-
lumn Valves: Closed“ 

P3 ist das Vakuum an der Ka-
mera 
 
P1 ist das Vakuum am Buffer-
Tank 
 
P2 ist das Backing Line Va-
kuum 
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4. Probe in den Single-Tilt-Probenhalter einlegen 

 

 
 

 Der messingfarbende Teil zwischen O-Ring und Kopfende des Halters darf niemals mit der Hand 

oder anderen nicht vakuumtauglichen Teilen berührt werden. ggf. Schutzhandschuhe tragen.  

 Drücken Sie mit einer Hand leicht gegen das schwarze Ende des Halters, damit er nicht aus der 

Schutzröhre rutschen kann.    

 Stecken Sie das Werkzeug (befindet sich im Halter, siehe Abbildung) in die Bohrung am Kopfende 

der Klammer. Dann heben Sie die Klemme vorsichtig und ohne Kraft gerade nach oben bis sie im 

rechten Winkel zum Halter steht (siehe Foto). 

 Platzieren Sie die Probe möglichst mittig in die kreisförmige Vertiefung der Spitze des Probenhal-

ters. Die Probe wird mit der kleinen Proben-Saugpumpe möglichst am Rand angehoben (oder al-

ternativ mit einer Pinzette). Für TEM & STEM sollte die Probe so rum eingelegt werden, dass das 

zu mikroskopierende Material jetzt unten liegt. Beim Einbau in das TEM wird der Probenhalter um 

180° gedreht, wodurch dann das Material dann nach oben zeigt.  

 Senken Sie die Klemme mit dem Werkzeug vorsichtig und ohne Kraft gerade nach unten auf die 

Probe. Hierbei die Klemme führen und nicht schnappen lassen. Achten Sie darauf, dass die Probe 

richtig in Position bleibt. Die Feder im Probenhalter drückt die Klemme an die Probe an, es muss 

daher nicht selbst gedrückt werden. Stecken Sie das Werkzeug zurück in den Halter.  

 Ziehen Sie den Halter leicht aus dem Schutzrohr und drehen Sie den Halter um 180°, so dass die 

Probe nach unten zeigt. Tippen Sie ein paar Mal auf das schwarze Ende des Halters. Drehen Sie 

den Halter zurück und überprüfen Sie, ob die Probe sich nicht bewegt hat (Bewegung ist ein Zei-

chen dafür, dass es nicht richtig eingelegt und gespannt war). 

 Ziehen Sie den Halter aus der Schutzröhre und inspizieren Sie den O-Ring genau auf Dreck, Haare 

etc. unter der Lupe. Dreck kann vorsichtig mit einer Pinzette oder Zahnstocher entfernt werden.  

 Falls der O-Ring zu trocken geworden ist: Den O-Ring niemals selbständig fetten, sondern den Ge-

rätebeauftragten kontaktieren.  
 

Werkzeug-Halter       Werkzeug an der Klemme    

Hier kommt die Probe rein 
(Ø Probe = 3,05 mm)   



Kurzanleitung für TEM, Laboratorium für Nano- und Quantenengineering, Leibniz Universität Hannover 

Seite 7/48 

5. Probenhalter in die Compustage einbringen 

 Einmal mit der linken Hand an der Steuerung der Selected Area Blende anfassen, um ggf. statische 
Aufladungen zu entladen. Jetzt ruhig stehenbleiben.   

 Vorsichtig den Probenhalter mit dem kleinen Pin nahe der Halterspitze auf der 5 Uhr Position in 
die Compustage einbringen, so dass er in die kleine Kerbe innerhalb der Compustage hineinpasst.  
Alternativ: Probenhalter mit Pin auf 6 Uhr Position vorsichtig einbringen, bis man am Ende einen 
Wiederstand spürt. Dann auf 5 Uhr drehen, so dass der Probenhalter ganz hineingesteckt werden 
kann. (Hier ist die Warnlampe kurz an – das ist ok und normal)     

 Die Pumpe startet automatisch und evakuiert die Compustage. Die rote Warnlampe ist an: Pro-
benhalter nicht bewegen! Der Single-Tilt-Holder kann vorsichtig losgelassen werden. Der Double-
Tilt-Holder sollte die gesamte Pumpzeit vorsichtig gehalten werden.   

 Am Steuerinterface am PC muss der jeweilige Halter (Single bzw. Double) selektiert und mit dem 
kleinen Pfeilknopf ↵ bestätigt werden.  

 

 
 
 

 
 

 Nur für Double-Tilt: Das Kabel vom Halter an die Compustage anschließen. Das Kabel darf später 
nicht blockieren oder die Schutzkappe berühren (sonst werden Schwingungen eingekoppelt).    

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

5 Uhr Position 

12 Uhr Position 

6 Uhr Position 

Warnlampe: 
Wenn an, dann 
Probenstab nicht 
bewegen 
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 In der Vakuum-Overviev wird unten die verbleibende Pumpzeit angezeigt (180 Sekunden). (Erfah-
rene Benutzer*Innen stellen in dieser Zeit „save numbered“ in Digital Micrograph ein)  

 Wenn die Pumpzeit zu Ende ist, dann geht die Pumpe aus und die rote Warnlampe erlischt.  

 Dann sollte umgehend der Probenhalter ganz eingebracht werden: mit der linken Hand leicht ge-
gen die lilafarbene Fläche an der Compustage drücken und mit der rechten Hand den Probenhal-
ter vorsichtig gegen den Uhrzeigersinn so drehen, das der innere Pin auf die 12 Uhr Position 
kommt. Der außen sichtbare, große Pin nahe dem schwarzen Ende des Halters kommt so auf die 6 
Uhr Position. Dadurch wird die Compustage „aufgeschlossen“. Achtung: Das Vakuum zieht den 
Probenhalter hinein! Daher gut festhalten!  

 Den Probenhalter langsam bis zum Ende hinein gleiten lassen. Der große Pin verschwindet auf 6 
Uhr im Schacht. Prüfen, ob der Probenhalter ganz drin ist.     

 Ein paarmal locker gegen das Ende des Probenhalters klopfen. 

 Die große graue Schutzkappe anbringen.  
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6. Steuerpanel 

 
Linkes Steuerpanel (Left Control Panel = LPC) 

 
 

 
 
 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

Rechtes Steuerpanel (Right Control Panel = RPC) 
 
 
 
 
 

 
 

 
 
 
 
 

α – Tilt  
(Probenhalter um die 
α- Achse drehen, die 
entlang der Pro-
benstablängsachse 
verläuft)  

ß – Tilt  
(Probenhalter um die 
ß- Achse drehen. Nur 
mit Double-Tilt-Hol-
der)  

Track-Ball, um die Strahlposi-
tion zu verändern. Darüber 
sind die zugehörigen 
Fein/Grob-Regler   

Intensity, um den Strahldurchmesser 
zu verändern. Darüber die zugehöri-
gen Fein/Grob-Regler. Gearbeitet 
wird im leichten Überfokus -> Im Ur-
zeigersinn aufgedreht   

Stigmator an/aus.         
Die verschiedenen Stig-
matoren werden am PC-
Interface selektiert 

Multifunktionsregler X. 
Darüber sind die zuge-
hörigen Fein/Grob-Reg-
ler 

Linke Multifunktions-
knöpfe L1, L2 und L3 

Rechte Multifunktions-
knöpfe R1, R2 und R3 
(Auf R1 ist meist „Schirm 
öffnen/schließen“) 

Multifunktionsregler  Y  
Die zugehörigen 
Fein/Grob-Regler sind 
auf dem LCP über dem 
Multifunktionsregler X 

Magnification = Vergrößerung. 
 Im TEM Mode wird hiermit die Vergröße-
rung eingestellt. In Diffraction Mode wird 
hiermit die Kameralänge verändert 

Fokus: Mit dem inneren Knopf 
wird der Fokus eingestellt und 
mit dem äußeren Ring der Fo-
kus-Step geändert 

Darkfield:  
Wechselt zwischen 
Darkfield (Leuchte an) 
und normalen Bright 
Field 

Diffraction = Beugung 
Wechselt zwischen 
Beugung (Leuchte an) 
und normalen Bild  

Wobbler An/Aus. 
Dies ist der Fo-
kus-Wobbler 

Eucentric Focus  

Joystick: Compustage 
X-Y Bewegung. Dar-
über sind die zugehöri-
gen Fein/Grob-Regler 
 

Z-Aches der Com-
pustage. Die Be-
wegungs-ge-
schwindigkeit 
hängt vom Druck 
ab 
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7. Alignements  

 Abdunkeln 
Für gewöhnlich ist das Licht beim Mikroskopieren aus. Mit dem Dimmer (rechts neben des TEM) 
kann man sich etwas dämmriges Licht machen.    

 Column Valves öffnen  
Der phosphoreszierende Schirm im TEM muss geschlossen sein. Wenn der Druck in der Column 
IGP1 ≤ 20 ist, dürfen die Colum Valves geöffnet werden. Der Druck sollte weiter auf 6 fallen. 
Wenn der Druck nicht 20 bzw. 6 erreicht, dann sollte der Probenhalter wieder ausgeschleust und 
der O-Ring auf Dreck untersucht werden.  

 FEG-Register Laden (Optional) 
Wenn das Strahl-Alignement sehr schlecht aussieht, dann sollte ein älteres, bekanntes FEG-Regis-
ter für TEM-Modus geladen werden. Oder natürlich, falls man den Modus ändern will (TEM, 
STEM, Tomografie). Dazu Setup -> FEG-Registers öffnen, siehe Abbildung. Ein Register selektieren 
und dann Set drücken, um es zu laden. Das TEM arbeitet mit den individuellen Einstellungen jeder 
Nutzerin und jedes Nutzers weiter, bei denen er die letzte Session beendet hat. Wenn also im glei-
chen Modus weitergearbeitet wird, dann sollte das laden neuer FEG-Register die Ausnahme sein.   

 

 
 

 Spotzise kontrolieren 
An dieser Stell sollte kontrolliert werden, ob Spotsize = 3 (für TEM-Mode) eingestellt ist (sonst än-
dern). Ohne Probenhalter schaltet das TEM aus Sicherheitsgründen automatisch auf Spotsize = 5  
 

 
 

 Strahl finden 

 Oft ist der Strahl auf dem Grid der Probe -> Joystik etwas bewegen (xy-Postion ändern). Das 
funktioniert fast immer. Sonst kann man noch versuchen:   

 Die Magnification ist zu groß -> auf 4400 x bis 1500 x stellen 

 Die Strahlhelligkeit ist sehr weit weg vom Fokuspunkt -> Am LCP die Intensität verändern  

 Vielleicht ist der Strahl nicht in die Mitte des Schirms gerichtet -> Magnification ganz klein ma-
chen und mit dem Trackball am LPC die Position ändern 

 Wenn nichts mehr geht: Anderes FEG-Register laden.  
 

 Condenser Apertur C2 mittig einstellen 

 Für TEM-Mode ist C2 auf 3.  

 Magnification etwas erhöhen, mindestens 44.000 x 

 Mit Intensity am LCP den Strahl zu einem kleinen Punkt fokussieren. 

 Mit dem Trackball am LCP den Punktstrahl absolut mittig auf den phosphoreszierenden 
Schirm ausrichten. 
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Schnellere Methode  

 Dann den Strahl mit Intensity im Uhrzeigersinn ganz aufziehen, so dass fast der gesamte 
Schirm ausgeleuchtet ist.    

 Mit den X- und Y-Einstellknöpfen der Aperture wird diese so justiert, dass der aufgezogene 
Strahl möglichst mittig ist. Dabei kann sich an den vier äußeren Markierungen auf dem phos-
phoreszierenden Schirm orientiert werden.  

 Die ganze Prozedur wird iterativ wiederholt, bis der Strahl mittig bleibt und sich gleichförmig 
aufzieht (sowohl im Uhrzeigersinn, als auch gegen den Uhrzeigersinn).   

 Genauere Methode 

 Dann den Strahl mit Intensity in Uhrzeigersinn soweit aufziehen, so der 4 cm Ring am Schirm 
ausgeleuchtet ist.  

 Mit dem Trackball exakt auf den 4 cm Ring legen.  

 Jetzt Intensity in den Unterfokus gehen (gegen den Uhrzeigersinn) und wieder den 4 cm Ring 
ausleuchten. Die Differenz zum zwischen dem 4 cm Ring und dem runden Strahl ist die Fehl-
justierung. 

 Jetzt mit den X- und Y-Einstellknöpfen wird die Blende so justiert, dass der Strahl etwas bes-
ser zum 4 cm Ring liegt (aber nicht perfekt).  

 Und wieder zurück in den Überfokus mit Intensity und sehen, wie gut es jetzt passt. 

 Die ganze Prozedur wird iterativ wiederholt, bis der Strahl mittig bleibt und sich gleichförmig 
aufzieht (sowohl im Uhrzeigersinn, als auch gegen den Uhrzeigersinn). 
 

 Euzentrische Höhe einstellen 
Es gibt mehrere Methoden, die alle beherrscht sein sollten. Vorzugsweise wird immer die Probe in 
z-Richtung so verschoben, dass sie in der euzentrischen Höhe liegt (und nicht der Fokus auf die 
Probe verschoben). Dadurch ist u. a. die Kalibrierung der Maßstabs-Anzeige am genausten, da alle 
Basis-Alignments des TEM für die euzentische Höhe vorgenommen wurden.       

 
Methode: Minimaler Kontrast 

 Eucentric Focus am RCP drücken. Damit wird der in den Basis-Alignments des Geräts 
festgelegter Fokus für die euzentrische Höhe eingestellt. 

 Eine Vergrößerung von 30.000 – 50.000 x einstellen. 

 Ein Probendetail suchen 

 Mit den Knöpfen für die z-Achse am RCP wird die Probe so hoch- und runtergefah-
ren, dass das Probendetail minimalen Kontrast hat.  

 
Methode: Minimale Streuung 

 Eucentric Focus am RCP drücken.  

 Eine Vergrößerung von 30.000 – 50.000 x einstellen. 

 Ein Probendetail suchen. Am besten sind Ansammlungen von amorphen Material.  

 Den Strahl mit Intensity am LCP auf einen Punkt zusammenziehen.  

 Mit den Knöpfen für die z-Achse am RCP wird die Probe so hoch- und runtergefah-
ren, dass die Streuung um den mittigen hellen Punkt minimal wird.  

 
 
 

X- und Y-Ein-
stellknöpfe für 
die Apertur 
 

Einstellrad für die Größe der 
Blende (TEM: Position 4) 
 

Der phosphoreszierende 
Schirm im TEM (Skizze) 

4 cm Ring 
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Methode: Fokus Wobbler 

 Eucentric Focus am RCP drücken.  

 Eine Vergrößerung von 30.000 – 50.000 x einstellen. (Hängt auch stark von der 
Größe des Probendetails ab).  

 Ein Probendetail suchen. 

 Jetzt das Probendetail mit den Augen gut fixieren und den Fokus-Wobbler mit dem 
Knopf „Wobbler“ am RCP starten. Dadurch wobbelt jetzt der Strahl um die Probe 
(ähnlich wie beim α–Wobbler, wo die Probe im festen Strahl wobbelt – die Relativ-
bewegung ist dieselbe).  

 Amplitude und räumliche Richtung des Wobbelns können mit den beiden Multifunk-
tionsreglern verändert werden.  

 Durch das Wobbeln erhält man zwei sich überlagernde Bilder der Probe. Mit den 
Knöpfen für die z-Achse am RCP wird die Probe so hoch- und runtergefahren, dass 
die beiden Bilder wieder übereinanderliegen. Ggf. mit dem Joystick korrigieren, da-
mit das Probendetail nicht aus dem Bild wandert. 

 Wenn die euzentrische Höhe richtig ist, dann kann man die Wobbler-Amplitude so-
wohl groß und als auch klein einstellen, ohne dass sich das Bild verändert. Wobbler 
wieder ausstellen.   

 
Methode: α–Wobbler 

 Eucentric Focus am RCP drücken.  

 Eine Vergrößerung von 30.000 – 50.000 x einstellen. (Hängt auch stark von der 
Größe des Probendetails ab).  

 Ein Probendetail suchen und in die Mitte des Schirms fahren.  

 Jetzt den α–Wobbler starten. Dadurch verkippt sich der Probenhalter periodisch um 
die α–Achse. Der α–Wobbler kann entweder über eine der Multifunktionstaste L1 
oder über das User Interface der Compustage (siehe Abbildung) gesteuert werden. 
Dort kann man auch die Amplitude einstellen, z. B. auf 5.  
 

 
     

 Mit den Knöpfen für die z-Achse am RCP wird die Probe so hoch- und runtergefah-
ren, dass die Bewegung des Probendetails minimiert wird. 

 Wenn die Bewegung des Probendetails minimal ist, dann ist man im Fokus und der 
α–Wobbler kann ausgestellt werden.   
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 Alignment: Gun Tilt (Optional) 
Gun Tilt und Gun Shift müssen nur neu gemacht wer-
den, wenn die Strahlintensität zu schwach geworden 
ist. Typische Werte für den Screen Curent ~10 nA und  
Exposure Time ~ 0.5 s. 

 Typische Vergrößerung einstellen, z. B. 44.000 x 

 Den 4 cm Ring ausleuchten (im Uhrzeigersinn auf-
gezogen) 

 Alignments –> Direct Alignments -> Gun Tilt ankli-
cken.  

 Jetzt mit den beiden Multifunktionsreglern den 
Strahl hin und her bewegen, so dass die Exposure Time minimal eingestellt wird. Ggf. 
mit dem Trackball den Strahl wieder in die Mitte bringen. 

 Mit Done beenden.  
 

 
 
 

 Alignment: Gun Shift (Optional) 
Gun Tilt und Gun Shift müssen nur neu gemacht werden, wenn die Strahlintensität zu schwach 
geworden ist.  

 Typische Vergrößerung einstellen, z. B. 
44.000 x. Wenn sich der Spot im Folgen-
den aus dem Sichtfeld bewegt, dann erst 
mal bei einer kleinerer Magnification be-
ginnen. 

 Spot Size mit R3 auf 9 stellen.  

 Den Strahl mit Intensity punktförmig zu-
sammenziehen und mit dem Trackball 
zentrieren. 

 Spotsize mit L3 auf 3 stellen. (Jetzt ist er 
nicht mehr in der Mitte, wenn Gun Shift nicht ideal ist) 

 Gun Shift in den Direct Alignments anklicken. 

 Den Strahl mit Intensity punktförmig machen und mit den beiden 
Multifunktionsreglern zentrieren.  

 Done drücken, wenn fertig.  

 Die letzten Schritte iterativ wiederhohlen, bis sich der Strahl nicht 
mehr bewegt, wenn die Spotsize von 9 auf 3 geändert wird.   

 Wenn sich die Exposure Time wieder erhöht hat, dann wieder Gun 
Tilt erneut einstellen. 

 Ggf. den Astigmatismus der Condenser Lens erneut korrigieren.  
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 Alignment: Astigmatismus der Condenser Lens  

 Wenn der Strahl am phosphoreszierenden 
Schirm nicht rund ist, muss der Astigmatismus 
der Condenser Lens korrigiert werden. 

 Stigmator am LCP drücken. 

 Am PC-Interface muss der richtige Stigmator 
(hier: Condenser) selektiert werden. Das Menü 
ist bei Alignements -> Stigmator.  

 Mit den beiden Multifunktionsreglern lässt sich 
der Strahl jetzt leicht in eine runde Form brin-
gen. Am einfachsten am 4 cm Ring am phospho-
reszierenden Schirm orientieren.   

 Zum Schluss Stigmator erneut drücken, um die Steuerung auszumachen.  
 

 Alignment: Pivot Points 

 Typische Vergrößerung einstellen, z. B. 175.000 x 

 Den Strahl mit Intensity punktförmig zusammen-
ziehen und mit dem Trackball zentrieren. 

 Beam tilt pp X anklicken. Der Strahl wobbelt jetzt 
hin und her. 

  Den Strahl mit den beiden Multifunktionsreglern 
so einstellen, dass er in der Mitte einen hellen 
Punkt hat, um den der Strahl wobbelt (siehe Ab-
bildung).  

 Done drücken, wenn fertig.  

 Dasselbe für Beam tilt pp Y. 
  

 
 
 

 Alignment: Beam Shift 

 Typische Vergrößerung einstellen, z. B. 175.000 x 

 Den Strahl mit Intensity punktförmig zusammen-
ziehen und mit dem Trackball zentrieren. 

 Beam Shift drücken. Der Strahl macht jetzt einen 
Satz zur Seite. Wenn er aus dem Sichtfeld ver-
schwindet, dann die Magnification reduzieren, 
bis man ihn wiederfindet.  

 Den Strahl mit den beiden Multifunktionsreglern 
zentrieren.  

 Done drücken, wenn fertig.  
 
 
 
 
 

Pivot Points: Richtig   Pivot Points: Falsch  Pivot Points: Falsch  
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 Alignment: Rotation Center 

 Typische Vergrößerung einstellen, z. B. 175.000 x 

 Den Strahl mit Intensity punktförmig zusammen-
ziehen und mit dem Trackball zentrieren. 

 Rotation Center Drücken. Der Strahl beginnt jetzt 
zu oszillieren. Mit dem Ring an dem Fokus-Regler 
kann man die Amplitude des Oszillierens ändern.  

 Mit den beiden Multifunktionsreglern kann die 
Bewegung des Strahls beeinflusst werden. Er soll 
so eingestellt werden, das er mittig oszilliert (und 
nicht hin- und her), siehe Abbildung. 

  Done drücken, wenn fertig.  

 Wenn Rotation Center eingestellt ist, dann kurz Beam Shift und Rotation center noch mal 
überprüfen, da die Alignements sich gegenseitig beeinflussen.  

 
 
 
 
 

 
 
 
 
 
 
 
 

 Alignment: Coma-Free (Optional) 
Nur bei Höchstauflösung für beste Bilder nötig. Coma-Free Alignement und Rotation Center beein-
flussen exakt die gleichen Strahlparameter – nur die Einstellmethode ist verschieden.     

 Magnification sehr groß einstellen, 440.000 x 

 Ein Probendetail in die Mitte des Schirms bringen und den Strahl mit dem Intensity 
weit aufziehen. 

 Jetzt Coma-Free Alignement X drücken. Dadurch beginnt der Strahl hin- und her zu 
springen. Der Strahl sollte soweit aufgezogen sein, dass das Probendetail immer sicht-
bar bleibt.   

 Jetzt mit dem Multifunktionsregler am LPC das Probendetail beim hin- und hersprin-
gen gleich scharf einstellen. Am besten sieht man es in Digital Micrograph in der FFT. 
Das Probendetail selbst wird beim hin- und herspringen etwas unterschiedlich ausse-
hen, da der Strahl es auf verschiedenen Wegen durchleuchtet.    

 Dasselbe für Coma-Free Alignement Y.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Rotation Center: Richtig   
Der Strahl oszilliert um ei-

nen hellen Punkt in der 
Mitte  

Rotation Center: Falsch 
Der Strahl oszilliert um ei-
nen hellen Punkt am Rand  

Rotation Center: Ganz falsch  
Der Strahl oszilliert so stark hin und 

her, dass ein hantelförmiges Bild 
entsteht 
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 Alignment: Astigmatismus der Objective Lens 
Dieses Alignement wird mit Unterstützung der FFT in Digital Micrograph gemacht.  

 Bei gedrückter ALT-Taste wird ein gepunktetes Quadrat auf das Live-Bild gebracht. (Weit links 
oben beginnen und dann aufziehen).    

 Dann wird davon die Fast Fourier-Transformation genommen.  

 Process -> Live -> Reduced FFT 
 

 
 
 

 Im Live-Bild der FFT sieht man Kreise, falls die euzentrische Höhe nicht ganz richtig eingestellt 
ist. 

 Jetzt kann man mit z-Achse am RCP die euzentrische Höhe ideal einstellen. Dann ist in der FFT 
das Bild gut ausgeleuchtet. 

 Dann mit dem Fokus-Knopf wieder etwas in den Unterfokus gehen, um die Kreise in der FFT 
zu sehen.   

 

   
Richtig: Runde Kreise 
 
 

Falsch: Nicht rund  Falsch: Statt runder Kreise kann 
zu solchen Mustern kommen 

 

 Sind die Kreise im FFT oval, dann muss der Astigmatismus der Objektiv-Linse korrigiert wer-
den. Hierfür Stigmator am LCP drücken. Bei sehr starkem Astigmatismus ist vermutlich die 
Objektiv-Blende nicht gut eingestellt (ggf. noch mal korrigieren).  

 Am PC-Interface muss der richtige Stigmator (hier: Objectiv) selektiert werden. Das 
Menü ist bei Alignements -> Stigmator. Als Default ist bei drücken des Stigmator-Knop-
fes bereits der Objektiv-Stigmator selektiert.  

 Jetzt mit den beiden Multifunktionsreglern die Kreise möglichst rund machen. Manch-
mal ist es hilfreich, sich einen Kreis aus dem oberen Menu in das FFT-Bild zu legen, um 
genau zu sehen, wann die Kreise rund sind.     

 Zum Schluss Stigmator wieder drücken, um die Steuerung auszumachen.  

 Mit dem Fokus-Knopf wieder in den Fokus gehen.  

Gepunktetes 
Quadrat selektie-
ren und bei ge-

drückter ALT-Taste 
ein quadratisches 
Gebiet auswählen

Dann die Reduced 
FFT davon starten
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8. Messen mit Digital Micrograph 

 

 Bilder speichern:  

 Mit „Save Numbered“ muss man nur einmal die Probenbezeichnung und das Datum eingeben. Bei 
jedem speichern werden dann die Bilder automatisch bezeichnet und mit einer fortlaufenden 
Nummer versehen.  

 
 
 
 
 
 
 
 

 File -> Global Info -> Saving -> Save Numbered 

 Dort dann angeben:  

 Den Pfad, wo es gespeichert werden soll (Bitte das eigene Verzeichnis).  

 Den String, der die Dateien bezeichnen soll. Typischerweise Probenname + Datum.  

 Next Index auf 1 stellen.  

 Save as Gatan Format.  

 Mit OK bestätigen.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

NEU: Auf dem Nut-
zer-Verzeichnis auf 

TEM Bilder spei-
chern
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 Bilder aufnehmen: 

 Der Strahl sollte den 4 cm Kreis gut ausleuchten.    
 
 
 
 
 
 
 
 

 Den phosphoreszierenden Schirm öffnen, so dass der Elektro-
nenstrahl auf die CCD-Kamera fällt. Dafür entweder R1 am RCP 
oder den mechanischen Knopf direkt links am TEM betätigen.   
 
 
 
 
 
 
 

 Mit dem „Start/Stop View“ Knopf im rechten Menu nimmt die 
Kamera Live-Bilder im schnellen Search Modus auf. (Wenn die Kamera am Anfang noch eingefah-
ren ist, dann fragt DM, ob man die Kamera rausfahren will: Ja). 

 Kamera Modes: 

 Search: Geringere Auflösung (mit Binning 2) mit schneller Wiederholrate für Echtzeit-Bilder. 

 Preview: Höhere Auflösung bei mittlerer Wiederholrate. 

 Acquire: Aufnahme des Bildes mit der eingestellten Exposure-Time.  

 Es wird ein gepunktetes Quadrat auf das Live-Bild gebracht. Dazu im Menu das entsprechend Sym-
bol selektieren, bei gedrückter ALT-Taste links oben ins Bild klicken und dann nach rechts unten 
aufziehen. Dann wird davon die Fast Fourier-Transformation erstellt. Unter Process ->Live -> Re-
duced FFT. Die FFT dient zur Kontrolle des Fokus und von Astigmatismus (siehe Alignements). 

 Normalerweise braucht man nur Search- und Acquire-Modus. Beide sind auf das gleiche 2004 x 
1336 große Feld eingestellt, wobei Search mit 0,1 Sekunden und Binning 2, Acquire mit Binning 1 
arbeitet. Das kann man durch drücken des kleinen Werkzeugsymbols überprüfen.    

 Normalerweise stellt man nur die Exposure time ein z. B. 1 Sekunde.     
 
 

Mechanischen Knopf 
für Lift Screen
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9. Kontrast-Blende 

Einen besseren Kontrast erhält man mit der Objektive-Blende als Kontrast-Blende. Allerdings 
schränkt eine Blende auch das maximal erreichbare Auflösungsvermögen ein. Typische 
Werte: Bei 50.000 x Blende 2, bei Hochauflösung 350.000 x Blende 4 oder keine Blende. 

 Der phosphoreszierende Schirm muss geschlossen sein. Sonst kann der Szintillator der 
Kamera beschädigt werden! Die Objektiv-Blende ist noch draußen.   

 Die Probenstelle, die man gerade im TEM sieht, wird im nächsten Schritt stark bestrahlt. 
Es empfiehlt sich daher ggf. etwas mit dem Joystick zu Seite zu fahren, um die interes-
sante Stelle nicht zu beschädigen.  

 Diffraction am RCP drücken. Dadurch wird jetzt die Zwischenbildebene der Objective 
Lens auf dem phosphoreszierenden Schirm abgebildet. Der Spot in der Mitte ist sehr 
hell. Mit dem Knopf „Magnification“ wird im Diffraction Mode die Kamera-Länge ein-
gestellt; hier 460 mm einstellen. Mit den beiden Multifunktionsreglern kann der Spot 
mittig eingestellt werden.  

  
 
 
 
 
 
 
 
 
 
 
Jetzt mit dem Einstellrad die Blendengröße einstellen und die Blende reinbringen (He-
bel nach links).   

 Mit den beiden x- und y- Einstellknöpfen an der Blende muss jetzt die Blende so einge-
stellt werden, dass der direkte Strahl möglichst mittig durchgeht.  

 Für Blende 1-2 sind die Blendenöffnungen im Vergleich zum Strahl sehr eng. Deshalb 
am besten den kleinen Hilfsschirm mit dem Hebel Links am TEM reinfahren und den 
Strahl durch das optische Mikroskop betrachten, wenn man die Blende justiert.  

 Zum Schluss wieder den Diffraction-Knopf drücken und in Bright Field zurückkehren.  
 
 
 
 

Einstellrad für 
Blendengröße

Hebel zum 
Ein- und Aus-

legen der 
Blende 

x- und y- 
Einstell-
knöpfe

Hebel für Hilfsschirm 
links am TEM 

Hilfsschirm Optisches Mikroskop 
zum Justieren 
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10. Beenden der Session 

 Vergrößerung auf SA 4400 x stellen und 4 cm Kreis am Schirm ausleuchten 
 

 Compustage in die Mitte fahren 
Erst mit dem Joystick in die Mitte fahren, dann kann der Rest 
mit Compusage -> Stage2  Flapout -> Reset: Holder gemacht 
werden.  

 

 Objektiv & SA-Blenden rausnehmen 
D. h. beide Hebel nach rechts. 

 

 Column Valves schließen 
 
 
 
 
 
 
 
 
 
 
 

 

 Kamera stoppen und zurückfahren 
„Stop View“ und uncheck „Camera Inserted“ in Digital Micrograph.  

 

 Probenhalter aus der Compustage entnehmen 

 Abdeckung der Compustage abnehmen.  

 Einmal mit der linken Hand an der Steuerung der Selected Area Blende an-
fassen, um ggf. statische Aufladungen zu entladen. Jetzt ruhig stehenblei-
ben. 

  Dann mit der linken Hand gegen die Lila-Fläche an der Compustage drü-
cken. Das ist wichtig, sonst kann die Compustage beim herausziehen des Probenhalters beschädigt 
werden.  

 Vorsichtig den Probenhalter herausziehen, bis man einen leichten Wiederstand spürt. Dann den 
Probenhalter im Uhrzeigersinn um etwa 180° drehen, bis es nicht mehr weitergeht. Dadurch wird 
die Compustage „abgeschlossen“.  

 Beim Double-Tilt-Holder: Kabelverbindung lösen.   

 Jetzt den Probenhalter vorsichtig gegen den Wiederstand herausziehen. Mit der linken Hand stabili-
sieren. Ab einem bestimmten Punkt geht es sehr leicht. Dann nicht mit dem Probenhalter gegen die 
Öffnung schlagen.   

 Falls an der Compustage noch die Rote Warnlampe leuchtet: Am Steuerinterface am PC „no holder“ 
selektieren und mit dem kleinen Pfeilknopf bestätigen. 
 

  Probe ausbauen 

 Der Teil zwischen O-Ring und Kopfende des Halters darf niemals mit der Hand oder anderen nicht 

vakuumtauglichen Teilen berührt werden. Ggf. Schutzhandschuhe tragen.  

 Probenhalter in die Haltevorrichtung zurückbringen.    

 Stecken Sie das Werkzeug in die Bohrung am Kopfende der Klammer. Dann heben Sie die Klemme 

vorsichtig und ohne Kraft gerade nach oben bis sie im rechten Winkel zum Halter steht. 

  Probe herausnehmen. Trick: Den Probenhalter drehen und die Probe direkt in die Probenbox fallen 

lassen.     

 Die Klemme wieder schließen.  

 Zum Schluss die Schutzkappe auf die Halterung schieben.  
 
 

Reset Holder
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 Leeren Probenhalter wieder in die Compustage einbauen 

 So bleibt der Halter sauber und es kommt weniger Dreck in die Compustage 

 Zum Schluss die Abdeckung der Compustage aufsetzen.   
 

 FEG auf 4500 V stellen (Wenn keiner mehr im Anschluss messen will) 
 

 Reste von flüssigem Stickstoff zurückgießen (Wenn keiner mehr im Anschluss messen will) 

 Den Sichtschirm am TEM mit der Gummi-Abdeckung abdecken. 

 Schutzbrille und Schutzhandschuhe anlegen. 

 Den Rest in der Kühlfalle und im Umfüllbehälter zurück in den großen Stickstoff-Behälter gießen.  

  Kühlfalle und der Umfüllbehälter werden kopfüber in die Styropor-Vorrichtung gelegt, so dass Kon-
denswasser aus den Behältern abtropfen kann.   

 Dort, wo die Kühlfalle am TEM stand, ein Papiertuch hinlegen, um Kondenswasser aufzufangen.   
 

 Cryo Cycle starten (Wenn keiner mehr im Anschluss messen will) 
1. Setup –Flapout > Cryo ->Cryo Cycle drücken. 
2. Nach 7 Minuten startet jetzt der Cryo Cycle automatisch. Das TEM User Interface kann 

beendet werden, das Programm für den Cryo Cycle läuft im Hintergrund weiter.  
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 

 Die drei Programme beenden (File -> Exit) 
 

 Ausloggen aus dem TEM-Steuerrechner (NICHT herunterfahren), Monitore ausmachen 

 Achtung:  Zwischen dem Beenden der drei Programme und dem Ausloggen sollten eine 
kurze Wartezeit (min. 10 Sekunden) eingehalten werden, damit alle Programme wirklich 
beendet sind.    

 Achtung: Manchmal friert der TEM-Steuerrechner direkt nach dem ausloggen ein oder 
stürzt ab. Dann dem Gerätebeauftragten Bescheid geben.     

 

 Daten verschieben 
Daten von TEM Bilder:\Nutzer\Nutzername verschieben nach TEM:\Nutzer Verzeichnisse\Nutzer-
name.  
 
 
 
 
 
 
 
 
 
 
 
 

7
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 Batch Convert der DM3-Dateien 
Die Bilder sind im DM3 Format und je 42 MB groß. Diese können mit Digial Micrograph oder auch 
mit der Freeware imageJ bearbeitet werden. Um die Bilder in Digital Micrograph in gebräuchliche 
Formate zu konvertieren: File -> Batch Convert. Dann den Ordner, wo die Bilder gespeichert sind, 
anwählen und noch das Format auswählen, in das konvertiert werden soll (BMP, JPEG oder TIFF). 
Mit OK bestätigen, dann werden die konvertierten Bilder im gleichen Ordner erzeugt.  

 
   

 Im Logbuch ggf. letzte Eintragungen machen und Computer im Vorraum herunterfahren (Wenn keiner 
mehr im Anschluss messen will)    

 

 Aufräumen!  
Das Labor sollte mindestens so aufgeräumt und sauber hinterlassen werden, wie man es vorgefunden hat.  
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TEM andere Modi 

11. Dark-Field Imaging  

Im normalen TEM-Modus (bright field, BF) wird der direkte Strahl (direct beam) aufgenommen, im Dunkelfeld-

Modus (dark field, DF) wird ein Teil des gestreuten/gebeugten Elektronenstrahls aufgenommen, wobei der di-

rekt beam mit der Objektiv-Blende abgeblendet wird. Daher geht DF-Imaging mit dieser Methode nur, wo auch 

eine Objektiv-Blende eingesetzt werden kann (d. h. im SA-Mode z. B. bei 50,000 x Maginification). Bei zu hohen 

Magnifications würde eine Blende die Auflösung beschränken.   

 Probe wie im normalen TEM-Modus einbauen, C2 einstellen, Euzentrische Höhe einstellen, direkt 

Alignements durchführen.  

 Z. B. 50,000 x Magification. Objektivblende auf 2 einbauen (siehe Alignement: Objective 

Aperture). Hierbei sollte der zentrale Strahl immer ideal mittig auf den Schirm kommen (ggf. mit 

den Multifunktionsreglern nachregeln).  

 Jetzt wieder im BF-Mode und die Blende rausnehmen.   

 Der Schirm ist geschlossen! Diffraction-Knopf am RPC Drücken. Jetzt hat man in der Mitte einen 

direct beam (hellen Punkt) und darum herum die gestreuten/gebeugten Strahlen. Camera length 

auf 650 mm (mit dem Magnification-Knopf einzustellen). Darkfield-Knopf am RPC drücken und mit 

den beiden Multifunktionsreglern den gewünschten Ring oder gebeugten Strahl in die Mitte brin-

gen. Der helle direct beam ist dann nicht mehr mittig. Mit dem Darkfield-Knopf kann zwischen 

diesen beiden Positionen gewechselt werden. Objektiv-Blende wieder reinschieben und testen. 

Jetzt sollte mal nur der direkt Beam und mal nur der selektierte Ring durchscheinen.  

 Difraction drücken und so zurück im bright field wechseln.  

 Schirm aufmachen und das bright field image mit Digital Micrograph sichtbar machen. Bild der 
gewünschten Probenstelle aufnehmen (im bright field). Darkfield-Knopf drücken und die gleiche 
Stelle aufnehmen. Meist muss die Exposure Time erhöht werden (z. B. von 0.2 s auf 1 s oder hö-
her), um ein scharfes Bild zu erhalten.  
 
 

  
Exemplarische Nanopartikel gemessen in bright field-modus (links) und die gleiche Probenstelle in 
Darkfield-Modus (rechts) 
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12. Selected Area Diffraction 

Durch den Beugungs-Modus (diffraction-mode) wird die hintere Brenneben (back focal plane) auf den Schirm 
oder Detektor abgebildet. Das Beugungsmuster ist ein Bild der in der Probe gebeugten und gestreuten Elektro-
nen. ACHTUNG: Die einzelnen Punkte (insbesondere der Punkt in der Mitte) des Beugungsbildes können sehr 
intensiv werden und dadurch der Szintillator der CCD- Kamera beschädigen! Deshalb:   

 Dieser Abbildungsmodus ist nur extra dafür eingewiesenen Nutzer*innen erlaubt! 

 immer mit höchster Vorsicht arbeiten!   

 Probe einbauen und einschleusen (für kristalline Proben ggf. double tilt holder nehmen, wenn α UND 
ß gekippt werden sollen) 

 Bei double tilt holder: Probe, Unterlegscheibe, konischer Ring. Erst etwas gegen den Uhrzeigersinn 
drehen, so dass man die Stelle findet, wo das Gewinde reingeht, dann im Uhrzeigersinn ganz vorsichtig 
ohne Kraft etwas rein drehen und "Butterweich" nur anziehen. Es muss plan abschließen (von der 
Seite angucken). Bei cross section Proben: Klebekante senkrecht zum Stab einbauen.  

 Probe wie im normalen TEM-Modus (bright field) einbauen, C1 einstellen, Euzentrische Höhe einstel-
len, direkt Alignements durchführen.  

 Probe mit α und ß ausrichten: Diffraction drücken (Schirm muss natürlich geschlossen sein!).  Im Bild, 
wenn die Probe dick genug ist, sieht man auch Kikuchi-Linien. Dann mit α und ß kippen, so das im Pol.  
Zum Schluss Diffraction drücken, um zurück in bright field zu gehen.  

 

    

DP mit Kikuchi-Linien.                                   Durch Kippen ist die Probe jetzt im Pol.  

Die Fotos zeigen die 111-Richtung von Silizium.  

Beispiele von Kikuchi-Linienin verschiedene Materialien gibt es im Wiliams Carter Band 2 (liegt im 
TEM-Vorraum aus). Online lassen sich Diffraction Pattern und Kikuchi-Linien für diverse Materialien 
berechnen unter:  http://emaps.mrl.uiuc.edu/  

 Das interessante Probendetail in die Mitte bringen. Selected Area Blende (unterste Blende reinbrin-
gen), Blendengröße einstellen (meist nr. 2 oder gar 1) und mit den beiden Reglern mittig einstellen. 
Falls man das Blendenloch nicht findet, dann mit der Magnifikation runtergehen, und danach wieder 
in die gewünschte Magnification.   

 Schirm geschlossen, um Kamera zu schützen! Jetzt Diffraction-Knopf am RPC drücken. Jetzt wird die 
hintere Brennebene abgebildet. 

 Mit den Multifunktionsknöpfen den zentral transmittierten Strahl in die Mitte bringen. Mit dem Mag-
nification-Knopf die Kamera-Länge einstellen, was in dieser Abbildung einer Vergrößerung entspricht 
(typisch: 285 oder 460 mm).  

 Den Strahl mit dem "Intensity"-Regler am LPC ausbreiten, bis das Muster Ringe zeigt, idealerweise mit 
Punkten bei kristallinen Proben. Dabei die Intensity so weit aufdrehen, dass der Strahl sehr schwach 
wird auf dem Schirm.  

 Fokussieren Sie das Beugungsmuster mit dem Fokus-Knopf RCP. Ggf. kann man das auch gut mit dem 
Lichtmikroskop am Hilfsschirm sehen.  

 
 
 
 
 
 
 
 

http://emaps.mrl.uiuc.edu/
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 Beam-Stopper reinbringen, so dass der zentrale Spot abgeblockt wird. Dies ist sehr wichtig, um die 
Kamera zu schützen!  
 

 

 
Evtl. den zentralen Spot mit den Multifunktionsreglnern nachjustieren, so dass er vom Beam-Stop-
per abgeblockt wird. 

 Im Folgenden: NICHT den Search-Modus in Digital Micrograph 
(oder TIA) benutzen, da sonst die Kamera bei jedem Search-
Vorgang beleuchtet wird. Ggf. „Stop-Viev“ in DM drücken. Den 
Schirm sicherheitshalber immer schnell nach jedem Bild 
schnell schließen.  

 In Digital Micrograph: Acquire mit Exposure time 0.01 s (bei 
Binning 1, was standardmäßig eingestellt ist). Schirm öffnen, 
schnell ein Bild aufnehmen, Schirm schließen und dann die 
max. intensity dieses Bildes ablesen. Hierfür das aufgenom-
mene Bild angeklickt und unter Analysis->Statistics->all die 
Statistik aufrufen und "Frame: Maximum…" ablesen. Es sollte max intensity nicht 7.000 überschrit-
ten werden. Jetzt einige Testbilder mit höheren Zeiten (bis zu 1 s) aufnehmen. Wenn die Exposure 
time gut eingestellt sind (gutes Bild bei nicht mehr als 7.000 max. intensity), dann das Bild aufneh-
men und speichern. 
  

 

 

 Fertig. Schirm geschlossen. Diffraction-Modus verlassen. Beam-Stopper raus.  SA-Blende raus.  
 
 
 
 
 
 
 
 
 
 
 

 

Hier Drehen, um den Beam-
Stopper rein/raus zu bringen

Rechts an der TEM-Säule ist die Steuerung für 
den Beam-Stopper

Hier Drehen, um den Beam-
Stopper etwas in der Länge zu 
verändern.
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13. STEM  

Im STEM (=Scanning TEM) wird der Strahl punktförmig zusammengezogen und damit die Probe abge-
rastert (wie in einem REM). Vorteile gegenüber normalem TEM sind die Möglichkeit viel besserer 
Auflösung/Höhere Vergrößerung und besserem Kontrast. Nachteile sind aufwendigere Justierung des 
Strahls, aufwendigeres Scharfstellen für jedes Bild und höhere Strahlendosis auf der Probe, wodurch 
die Probe noch freier von Verunreinigung sein muss.     
 

Für STEM hat Nicholas Rudawski (Univ. Florida) ein sehr hilfreiches Video insbesondere für Halb-

leiterschichten gemacht: „FEI Tecnai F20 S/TEM: STEM mode operation“ auf Youtube  
 

 Die Probe sollte möglichst sauber sein. Neue Proben sind in der Regel sauberer als alte Pro-
ben. Ggf sollten die Proben gecleant werden mit dem Plasmacleaner.  

 Für STEM muss das zu betrachtende Probenmaterial im TEM oben liegen (umgekehrt wie 
beim normalen BF TEM-Modus)! Daher die Probe im Probenhalter nach unten einbauen, da 
der Stab dann noch um 180° gedreht wird. 

 Noch mal überprüfen, ob die Objective und selected Area Apertures wirklich raus sind (He-
bel nach rechts).  

 Probe in das TEM einschleusen  

 Euzentrische Höhe einstellen (euzentric fokus drücken, mit z die Höhe so verstellen, dass der 
Kontrast minimal wird). 

 Kristalline Proben: Mit double Tilt holder einschleusen und Zonenachse einstellen d. h. beide 
Winkel richtig kippen, so dass die Atome im Gitter „hintereinander“ im Strahl sind und durch-
scheint werden können. Dass nahe der Oberfläche, Area of Interest (wo man Messen will). 
Später muss man das im STEM noch mal genauer machen.   

 Condenser Apertur C2 auf Position 4 drehen und mir den beiden Reglern an der Blende 
mittig einstellen. Ggf. Astigmatismus der Condenser-Linse (Strahl nicht rund) korrigieren. (Be-
merkung: Später wird C2 auf Position 2 gedreht für die Messungen. Position 4 ist notwendig, 
um das Ronchigram richtig einstellen zu können) 

 Im BF TEM-Modus die euzentrische Höhe einstellen: Eucentric focus drücken, z-Höhe einstel-
len (Wie in normalen TEM). Dann am besten in Digital Micrograph mit der FFT die z-Höhe 
exakt einstellen, so dass man wirklich zu 100 % in der euzentrischen Höhe ist.  

 Dann mit Column ->Image Settings-> Reset Def. den Wert von Focus auf null setzen. (Dies 
macht man, damit man später noch diese Höhe wiederfindet.)  
 

 

 
 
 
 

https://youtu.be/JtVmDOa--gg
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 Schirm muss geschlossen sein! Kamera zurückfahren (DM -> Stop View & Camera inserted: 
uncheck)! Weil gleich mit STEM der Defraction Modus gestartet wird und der direkte Strahl 
sonst die Kamera beschädigen könnte.  

 FEG-Register für STEM laden (mit Extraction Voltage = 4500 V, Gun Lense = 6, Spot Size = 10 
und Nanoprobe mode). Jetzt ist man im STEM-Modus, difraction ist ON.  

 Eucentric focus drücken.  
 

 Wenn mit EDX gemessen werden soll (Optional) 
Jetzt kippen auf typisch Alfa = +20,0 °   ,  
Spotzise = 5 . Dadurch wird der Strahl größer, was mehr Counts gibt, aber auch gröber abrastert. Je 
nach Probe gehen auch andere Spotsize-Werte.  

 
 User interface: STEM:  HAADF-Detektor selektieren in "Stem detector(user)",  

 

Camera Lengh = 200 mm einstellen.  
 

 

 

 Magnification 40.000 x einstellen und STEM: Search anmachen. Mit Focus-Knopf scharf stel-
len und dann wieder Search stoppen.  
Kein Bild? 
-> HAADF-Detektor noch mal raus- und wieder reinfahren. 
-> „INT SCAN“ muss an der Box für das EDX gedrückt sein. 

 Ronchigram: Magnification 7000 x STEM. Kameralänge 200 mm. Ronchigram entweder am 
kleinem Schirm mit dem optischen Mikroskop oder im DM search modus anschauen. Eine 
Amorphe Stelle suchen (z. B. Kohlefilm bei TEM-Gritts, Kleber bei MBE-Proben). Den Wert 
der jetzige z-Höhe gut merken. Die Z-Höhe so verändern, das Ronchigram gut aussieht. Fein-
justage mit Fokus-Knopf. Ronchigram in die Mitte bringen mit „Differental Alignment“. Dann: 
Stigmator: Condensor und mit den beiden Multireglern das Ronchigram einstellen (wenn es 
nicht rund ist).  

 

Kein R. (Fokus falsch)     R. etwas Astigmatismus      R. optimal 
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 Strahl zu Alignen im Ronchigram:   

 Rotation Center (intensity):  Focus Step auf 4, dann Direct Alignment: Rotation center drü-
cken und am Focus Step drehen, bis das wobbeln aufhört. Jetzt am Focus hin und her drehen 
(manuell wobbeln) und mit den Multireglern gegensteuern, so dass das Rotation Center ein-
gestellt wird. Ronchigram soll konzentrisch expandieren und kontrieren.  

 Stigmator: Condenser 
 Die Mitte des Ronchigram mit Beamstopper markieren. Dann C2 auf Position 2 (oder gar auf 

1) stellen. Anhand des Beamstoppers jetzt die Blende Mittig einstellen. Beamstopper raus. 
Schirm ggf. schließen.  

 

 

 Tia STEM: search modus. 256 x 256 pixel, 1 sec frame time. Kameralänge 100 mm (oder gar 
50 nm) einstellen. Vergrößerung deutlich höher.  

 STEM: Search läuft. Alignment: difraction alignment und Multifunctionsregler centern. 

 Contrast und Brightness einstellen: Unter dem Histogramm ist ein Knopf, wo man Hell-Dun-
kel vertauschen kann (wer will). Mit Auto C/B versucht TIA, Contrast und Brightness automa-
tisch gut einzustellen. Mit Scope sieht man Contrast und Brightness und kann es mit den 
Multifunktionsreglern (in der Steuerung anklicken) einstellen bzw. mit der Maus auf die Reg-
ler klicken.  

 Noch mal Probe mit α und ß ausrichten: Schirm geschlossen, STEM ist an.  Beam Position 
Marker in TIA auf eine Stelle im Kristall nahe der Area of Interest. Am Schirm kann man dann 
an genau dieser Stelle das Difraction pattern sehen. Magnification erhöhen. An amorpher 
Stelle z. B. Kleber die Höhe in den euzentrischen Fokus bringen.  Jetzt iterativ: α und ß vor-
sichtig verändern und in den Pol bringen (Zone Axis Alignment), jeweils in TIA die Höhe korri-
gieren z.  

 Mit Focus und Stigmator:condensor scharf stellen. Stigmator Steuerung aufrufen und jetzige 
Werte in ein anderes Register kopieren, damit es nicht verloren geht. Drehen, so dass es 
schärfer wird.  

 Atomic Level: Magnification sehr hoch 1.8 Mio min, 5-7 Mx. Slowly focus mit Stig:condensor 

 Wenn alles gut aussieht: Bild aufnehmen mit Acquire.  
 Abspeichern der Bilder: Save as: *.emi file.  Die Bilder können dann mit TIA wieder geöffnet 

werden (gibt es im TEM-Vorraum auf dem PC dort) oder mit ImageJ (benötigt extra Plugin). 
In TIA kann man die Bilder exportieren mit: Rechtsklick auf Bild, export data: Save as: With 
Scale! Wichtig, sonst ohne Scale. Zb. JPG w/scale 

 Beenden: STEM aus, FEG register für TEM laden. Blende C2 wieder auf 3 stellen und mittig 
machen.  Dann wie bei TEM BF beenden. (Blenden raus, 4400 x magnification, reset holder, 
column valves schließen, Probe ausbauen, aufräumen, ggf. Cryo circle starten).  
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14. STEM-EDX 

 
 Wichtig: Das Programm „clmserver“ auf dem TEM Rechner muss gestartet sein. Dies ist in der 

Taskleiste sichtbar. Ist es nicht an, können die Daten (z.B. eingestellte Vergrößerung) nicht vom 
TEM an den EDX Rechner übertragen werden. Eine Fehlermeldung beim Starten der TEAM 
Software weist darauf hin. Dann „clmserver.exe“ manuell starten (C:\Edax32\IMG) und TEAM 
Software neu starten. 

 
 

 Proben, an denen EDX Messungen durchgeführt werden sollen, müssen sehr sauber sein und 
lange/hohe Strahlendosen aushalten können. Es empfiehlt sich dies zunächst durch Aufnahme 
eines STEM Bildes zu prüfen. Wenn hier schon eine Zerstörung der Probe oder Verbrennen 
von Verunreinigungen sichtbar ist, kann eine weitere Probenvorbereitung notwendig sein. In-
tensiveres Waschen (oder, wenn die Probe es zulässt, Plasma cleanen) kann Abhilfe schaffen. 

 
 Probeneinbau und Einstellungen wie in STEM beschrieben. Probenhalter muss auf ca. 20° ge-

kippt werden. Dabei gilt zu beachten, dass ein größerer Strahl (über Spotsize oder die C2 
Blende einstellbar) zu deutlich mehr Signal führen kann, aber entsprechend die Auflösung der 
Messung verringert. Dies muss von der Probe abhängig entschieden werden. 

 
 Edax-PC starten, Einloggen mit dem Passwort „apollo“, TEAM Software starten 

 
 In der TEAM Software anmelden, ggf. neuen User anlegen. 

 

 
 

 Neues oder existierendes Projekt auswählen und eine Probe anlegen. 
 

 Vor der Messung muss der EDX Detektor eingekühlt werden. Dazu auf rechts das Menü aus-
klappen und im Reiter „EDS Detectors“ auf die rote Schaltfläche „Cooling Off“ klicken. Diese 
wechselt dann zu gelb, „Cooling On“, und wird grün, wenn der Detektor bereit ist. Dies wird 
ebenfalls über das Thermometer-Symbol im Kasten unten rechts angezeigt und kann auch dar-
über gesteuert werden. Wenn der Status grün ist, kann der Detektor eingefahren werden. 
Dazu auf die Schaltfläche „Move In“ klicken oder auf den Pfeil (neben dem Thermometer im 
Kasten unten rechts) klicken. 
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 Das Bild des TEM ist immer nur auf einem Rechner verfügbar. Mit dem Kasten kann dies um-
gestellt werden zwischen Int Scan (Bild auf TEM Rechner/TIA Software) und EDX scan (Bild auf 
EDX Rechner/TEAM Software) 

 

 
 
 

In der TEAM Software: 
 

 Achtung auf ausreichendes Signal (cps). Die aktuellen cps werden unten links angezeigt. 

 
 
Wenn diese sehr gering sind: 

 Ist tatsächlich Probe im Strahl?  

 Ist der Probenträger gekippt (nötig sind Winkel 20-40°)? 

 Ist der EDX-Detektor an und reingefahren? 
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 Auswahl der Messung über die oberste Reihe. Es können reine Spektren („Spectrum Only“), 
Elementarverteilung in einem Bild („Mapping“) oder auf einer bestimmten Linie/Punkt („Line 
Scan“ bzw. „Point Analysis“) der Probe gemessen werden. Über „Multifield Analysis“ lassen 
sich mehrere dieser Operationen in einer Anweisung kombinieren. Im Weiteren wird ein Map-
ping als Beispiel beschrieben. 

 

 
 

 Vor der Messung ein Bild der Probenstelle aufnehmen. Dazu mit der Maus über den Reiter 
„Image Area“ gehen, hier lässt sich die Auflösung dieses Bildes einstellen und weitere fortge-
schrittene Einstellungen über die Schaltfläche „Advanced“ oder direkt im Menü an der rechten 
Seite. Durch Klicken auf den Reiter wird ein Bild aufgenommen. 

 
 Um die Abbildung der Probenstelle erscheint ein grüner Kasten. Mit diesem kann der Bereich, 

der untersucht werden soll, nochmals feiner eingestellt werden. 
 

 
 

 Zunächst wieder mit der Maus über den Reiter „Collect Map“ gehen. Einstellungen auf ma-
nual! Nur dies erlaubt das freie Einstellen der dwell time (Zeit die der Strahl an einem Mess-
punkt verweilt) und der frames (wie oft soll die Probe ab gerastert werden und die Messungen 
addiert). Zunächst mit sehr geringer Auflösung starten und diese dann anpassen. 

 

 
 

 Mapping durch Klicken auf den Reiter „Collect Map“ starten. Durch erneutes Klicken auf den 
Reiter wird das Mapping abgebrochen und im jetzigen Zustand gespeichert. 

 
 Hacken setzen bei „Elemente zuweisen“. Wenn das Mapping beginnt, die relevanten Elemente 

im angezeigten Periodensystem auswählen und bestätigen. 
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 Die Farbe, die für die Elemente verwendet wird kann über „Display Options“ -> „Assign Ele-
ment colors“ angepasst werden. 

 

 
 Nach dem Mapping steht auf dem Reiter „Finish“, durch Klicken auf den Reiter diese Proben-

stelle abschließen. 
 

 Die Messungen können zusammengefasst als pdf-Report (über Klicken auf den Reiter „Re-
port“) exportiert werden. Einzelne Bilder können über Klicken auf das Ordner Symbol an die-
sen exportiert werden. Dazu im Nutzer*innenprofil (durch Klicken auf das Profilbild oben 
rechts) die „custom image folder location“ angeben und das „send to folder filename format“. 
Die Bilder befinden sich dann im angegebenen Ordner in einem Unterordner benannt nach 
dem Projekt, mit dem entsprechenden Namen. 

 

 
 
 

 Am Ende: EDX-Detektor wieder rausfahren, Kühlung beenden, Programm TEAM beenden, 
Rechner runterfahren 
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Problemlösungen  

15. Bekannte Probleme & Lösungen 

 Compustage zeigt rote Lampe zu Beginn der Session 

 Select „No Holder“ und Enter, dann sollte es gehen 

 Gatan Digital Micrograph will plötzlich keine Bilder mehr aufnehmen /Gibt unsinnige Fehlermeldun-
gen 

 Dann hat man vermutlich bereits viele Bilder gemacht. Die müssen geschlossen werden. Dann 
sollte es wieder gehen. Die vielen Bilder nehmen zu viel Platz im Arbeitsspeicher weg.  

 Auf allen Bildern sind immer an der gleichen Stelle komische Flecken oder ein Intensitätsverlauf von 
einer Seite zur anderen 
Die Gain-Referenz der CCD- Kamera muss neu gemacht werden => Den Gerätebeauftragten informie-
ren.  

 Vakuum Einbruch beim Probe-Einschleusen 
Wenn beim Einbringen des Probenhalters das Column-Vakuum einbricht, dann: 

 Dem Gerätebeauftragten Bescheid geben. Wenn der nicht kann, dann kann man versuchen:   

 Probenhalter vorsichtig entfernen 

 Ausloggen 

 Als Supervisor einloggen (siehe kleines TEM-Buch am TEM für Username und Password) 

 Microscope interface starten 

 Vakuum Übersicht öffnen 

 Vakuum -> Flapout -> Vakuum „to Ready State“ knopf drücken. Diesen Knopf hat man als nor-
male Nutzerinnen bzw. normaler Nutzer nicht. 

 Warten, bis das Vakuum wieder normal ist. 

 Den Vorfall im Logbuch notieren.   

 Software Absturz 
Wenn die Software abstürzt: Software neu starten. Evtl. muss mit dem Task-Manager ESVision.exe 
vorher beendet werden.  

 Bild wackelt plötzlich periodisch 
Vielleicht ist die Compustage abgestürzt. Dann kann man z. B. keine Track-Punkte mehr setzen. => Pro-
benhalter ausbauen. Compustage neu starten (Compustage flapout letzer Reiter auf Enable aus und 
wieder anmachen. Die Compustage kalibriert sich neu. Dauert ca. 5 Minuten)  

 Wasserkühler in Störung 
Einmal aus- und wieder an machen (linke Taste) am Kühler. Ggf. etwas Wasser nachfüllen, so dass das 
Wasser 1 cm unter den Rand gefüllt ist.   

 Steuerpanel ausgefallen 
Das Steuerpanel am Steuerrechner (USB an der Rückseite) aus und wieder einstöpseln.  Evtl. ist dann 
noch ein falscher Steuerbefehl irgendwo im Programm. Dann muss (sowas darf nur der Gerätebeauf-
tragte) der TEM-Server neu gestartet werden und ggf. sogar der TEM-Steuerrechner ganz neu gestar-
tet werden. Vorher FEG in Standby schalten und HT ausmachen.  

 Probe sehr lange „unruhig“, so dass keine Bilder aufgenommen werden können 
Tipp: Vorsichtig auf die Rückseite des eingebauten Probenhalters klopfen.  

 Die neu eingebaute Probe ist nicht in die Euzentrische Höhe zu kriegen, da diese „Out of Range“ liegt 

 Ist bisher einmal aufgetreten: Die kleine Halterung an der Spitze des Probenhalters 
hatte sich um 180 Grad umgedreht. Lässt sich vorsichtig zurückdrehen.     

 Steuerrechner stürzt ab oder „friert ein“ beim Ausloggen  
Wenn das passiert, muss der Steuerrechner neu gestartet werden. Leider muss dann auch der das Pro-
gramm „TEM-Server“, das Vakuum, die HT und evtl. die FEG neu gestartet werden. Bitte den Geräte-
beauftragten das machen lassen.   
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16. TEM-Server neu starten 

 
Wenn der Steuerrechner neu gestartet werden musste, ist dies notwendig. Dieser Schritt steht in keiner Anlei-
tung von FEI.  
 
 

 
 

 
 

 
 

 
 
Fertig! Dann das TEM User Interface öffnen, um das Vakuum zu starten. Vakuum-ON Knopf am Panel (Box) drü-
cken.  
 
 

 
 

Um den TEM-Server zu starten, 
muss das kleine Ikon rechts un-
ten angeklickt werden  
 
 
 
 
Start -> Microsope -> TEM selek-
tiert  
 
 
 
 
Dann einfach warten, bis das 
TEM-Symbol auftaucht 
 
…..sich aufbaut und grün wird 
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17. FEG und High Tension neu starten 

Da die Hochspannung (High Tension = HT) und die Feldemissionskathode (Field Emmission Gun = 
FEG) leider des Öfteren ausfallen, ist hier eine Kurzanleitung, diese wieder zu starten. Prinzipiell soll-
ten FEG und HT vorsichtig d h. nicht zu schnell gestartet werden, sonst kann es zu elektrischen Über-
schlägen kommen, die wiederum das TEM schädigen könnte.  
  

 Im ersten Reiter des Menüs (Setup) sind die Steuerungen für High Tension und FEG. Hier 
jeweils das Untermenu ausflappen (siehe Bild) 

 

So sieht es aus, wenn FEG und HT komplett ausgefallen sind.  
 

 Die FEG starten: 
 Power starten (falls Power aus ist). Wenn nur die HT ausgefallen war, dann ist Power 

noch an. Wenn Power neu gestartet werden muss, dann erscheint im FEG Menu der 
Hinweis "Status: Waiting for FEG IGP to start up". Das kann etwas dauern…Dann er-
scheint "Status: Ready for Warm/Cold Start" und es kann weitergehen. 

 Wenn die FEG länger als 48 Stunden aus ist, dann Cold Start drücken. Sonst mit Warm 
Start starten. Wenn man sich unsicher ist, wie lange die FEG aus ist, dann im Anlagen-
buch nachschauen. Cold Start dauert 90 mins, Warm Start dauert 27 mins.   

 

FEG starten: Entweder mit Cold Start oder mit Warm Start.  
 

 Dach ist die FEG an: Operate, Power und FEG-Knopfe sind an.  
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 HT Starten: 
 Wenn die FEG an ist, aber der Knopf „High Tension“ noch grau und nicht drückbar ist, 

dann muss VAC am Control Panel (kleiner Kasten) gedrückt werden.  
 0-20kV: High Tension Knopf drücken bei Ziel: 20 kV. Die High Tension wird jetzt relativ 

schnell auf 20 kV geladen (siehe Measured HT). 

 

Ziel 20 kV, High Tension drücken 
 

 20kV-160kV: "Free high tension" anklicken und Schritte 10.000 einstellen, und dann in 
10.000ern Schritten die HT langsam erhöhen. Hierbei die "Measured HT " beobachten 
und immer einen 10.000ern Schritten machen, wenn die Measured HT nahe dem Ziel-
wert kommt.  

 

 
 160kV-190kV:  "Free high tension" + Schritte 3.000 einstellen und in 3.000ern Schrit-

ten die HT langsam erhöhen. Hierbei die "Measured HT " beobachten und immer ei-
nen 3.000ern Schritten machen, wenn die Measured HT nahe dem Zielwert kommt.  

 190kV-200kV:  "Free high tension" + Schritte 1.000 einstellen 
 HT auf 200 kV: Das Häkchen bei "Free high tension" entfernen. Die beiden Unterme-

nüs von HT und FEG können wieder zugeflappt werden.  
 HT und FEG sind an. Der FEG-Strom steigt noch ca. eine Stunde, aber es kann schon gearbei-

tet werden. Den HT-Ausfall und Neustart in das Anlagenbuch eintragen.  
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18. Neuen TEM-User am TEM-Steuerrechner einrichten 

 Neuen Windows-User anlegen 
Als Supervisor einloggen (Siehe Rotes Buch am TEM) 
Start -> Programs -> Administrative Tools -> Computer Management 
Local Users and Groups -> Users 
Rechtsklick und "New User" 

User Name: <Nachnahme> 
Fullname: Vornahme + Nachname 
Description: Z.B. Doktorand*Inn Institutskürzel Professor*In 
Passwort: wie immer, sollen die Leute dann ändern 
Check-Box: "Password never expires" 
Create! 
Neuen User anklicken und Rechte vergeben: 
Doppelklick auf den User, Reiter "Member of" 
Add: Administrators, TEM Experts, Power Users 
(Jeweils Objekt-Name einfügen und Check Names drücken, mit OK bestätigen) 

 TIA Rechte 
Als Supervisor  
Programs -> FEI Company -> TIA -> TIA User Administration 
User -> Add User 
<Nachnahme> Eingeben, Checkbox "This is an administrator", und OK, "Create Directoy?"YES 
Fertig 

 Mouse Without Boarders 
Ab hier als der neue User einloggen   
Das Logo ganz rechts unten anklicken 
Passwort ändern zu: TECNAI200 
Aply and Close 

 Shortcuts anlegen 
Es sollen drei Shortcuts auf dem Desktop erzeugt werden: Jeweils im Datei-Explorer suchen, 
rechtsklick, Create Shortcut, auf den Desktop verschieben und ggf. umbenennen. 

a. C:Tecnai\Exe\Peoui.exe , "TEM User Interface" 
b. C:Program Files\Gatan\Digital Micrograph. "Digital Micrograph" 
c. C: Program Files\FEI\TIA\bin\ESVision.exe, "TIA 

 Cryo Circle 6 Pumpzeit 
TEM userinterface starten 
Setup -> Vakuum -> Flapout: Cryo und "Start After: 7 min" eintragen, kleines Return-Zeichen 
dort drücken für Eingabe. 
Ebenso einstellen: Pumpzeit 180 s.  

 DM auf zweiten Bildschirm 
Alle drei Programme starten 
Beim kleinem Menue rechts unten im TEM Userinterface auf das blaue Quadrat klicken 
Bei erscheinenden "Aplication Selection" auf das <> Symbol klicken 
Select application: Digital Micrograph, Check "put on 2nd monitor" und aply drücken 

 EDX vorbereiten  
Startup -> Shortcut to clmserver.exe reinkopieren. Das liegt in: c:\Edax32\IMG 
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 Verbindung mit dem Datenlaufwerk vom TEM-Rechner 
 Im Netzwerk gibt es das Laufwerk „TEM Bilder“ für die TEM-Nutzer*innen 
 Verbindung herstellen mit: Explorer öffnen, Tools -> Map Network Drive 

 

Dort bei Folder eingeben: \\10.74.134.188\TEM Bilder  und Finish drücken 
 

 
Dann muss man sich einmalig anmelden: User Name: TEM, Password: benutzer39  
Checkbox an bei „Remember my Password“ 

 
Dann ist man auf dem Laufwerk TEM Bilder   
Dort im Verzeichnis „Nutzer“ einen eigenen Ordner <Nachname> anlegen. 

 
 
 
 

TEM Bilder 
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 Workspace Layout 
Beim kleinem Menue rechts unten im TEM Userinterface "Workspace Layout" selektieren 
Screenshots des Standart-Layouts sind in TEM Bilder:Nutzer\FSW. Entsprechend das Layout 
editieren 
 gewünschte Dinge von rechts nach links in die Ordner ziehen 
 Zum Löschen Dinge rausziehen 
 Ordner umbenennen  
 Ordner Kopieren für neue Ordner 

Dann noch die Anzeigen Unten im TEM Userinterface editieren (Object Lese und Defocus 
hinzu)  
 

 FEG Register 
Setup -> FEG Register -> Flap Out: File Open.  
Das Register von FSW laden: usr_FSW.feg 
Das zuletzt gespeicherte FEG-Register für TEM laden (Selektieren und Set drücken. Dafür ggf. 
die FEG in Operate schalten und danach wieder aus). 
Ausloggen (NICHT herunterfahren). Fertig 

 
 Verbindung mit dem Datenlaufwerk von der LNQE-Domain 

Auf einem Rechner in der LNQE-Domain einloggen (z. B. dem Rechner im Vorraum beim 
TEM) 
Datei-Explorer öffnen, Dieser PC mit rechter Maustaste anklicken, dann Netzlaufwerk verbin-
den… anklicken 

 
  

Dort Ordner: \\10.74.134.188\TEM Bilder  eingeben.  
Checkbox an bei „Verbindung bei Anmeldung wiederherstellen“ 
Fertig stellen klicken. 
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Da ist jetzt das Laufwerk „TEM Bilder“ 
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19. Referenzen der Kamera neu Kalibrieren  

Typ: Gatan Orius SC 1000 CCD.  

 Alle Referenz-Files vorher sichern 
 Die Refs liegen in: c:\program files\Gatan\DigitalMicrograph\Reference Images 
 Die Files dort kopieren und in einem neu anzulegenden Verzeichnis im Unterordner „Backup Refe-

rences“ speichern 
 

 

 
 Strahl vorbereiten 
Probenhalter ohne Probe einbauen 
C2 mittig einstellen 
Direct Allignments 
Typische Vergrößerung (135 kx) 
Ein Bild mit Digital Micrograph aufnehmen zum späteren Vergleich (Bei ungleicher Intensität bei 
gleichzeitiger mittiger Ausleuchtung bedeutet, die Kamera muss in der Tat kalibriert werden) 
 

 Dark Referenz 
Schirm geschlossen, Colum Valves closed, Schwarze Plastik-Abdeckung drauf, alles dunkel (so gut 
es geht 
Digital Micrograph -> Camera -> Prepare Dark Reference  
Starten! Alle Fragen etc. mit yes beantworten 
Es werden 3 Images aufgenommen mit je 20 Aufnahmen + 8 kleine (ein streifiges Bild). Dauert ca. 
7 Minuten.  

 Gain Referenz 
Strahl an und 4 cm Kreis gut ausleuchten (d. h. 1 cm drüber)  
Typische Vergrößerung (135 kx) 
Testen: Intensity im Uhrzeigersinn drehen vergrößert den Strahl  
Schirm auf, Abdeckung drauf, Licht aus 
Digital Micrograph -> Camera -> Prepare Dark Reference  
Testbild aufnehmen 
Digital Micrograph -> Camera -> Prepare Gain Reference  
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Einstellen: Target intensity: 3000 und Frames to average: 10 
Starten! Alle Fragen etc. mit yes beantworten 
Es werden wieder diverse Bilder aufgenommen, dauert ca. 5 Minuten 
Evtl. ist zwischendurch die Intensität zu hoch, dann muss man vorsichtig den Fokusknopf im Uhr-
zeigersinn drehen, bis die Kamera wieder „im grünen Bereich“ ist und dann Proceed drücken 
 

 

 
 Test Bild 

Ein letztes Testbild machen. Wenn es jetzt gleichmäßig ausgeleuchtet ist, dann hat die Kalibrie-
rung gut funktioniert 
Troubleshooting: Sonst die Referenzen noch mal aufnehmen; wenn das nicht klappt, kann man 
nur alte Referenzen laden.  
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20. Wechsel einer Blende  

 Blenden sind aus Platin-Legierung, 3 mm rund, Dicke? 
 Gasförmigen Stickstoff anschließen am Wasser-Reck (steht dran) 
 Schon mal an der Blende vorsichtig aufdrehen, damit kein Überdruck entstehen kann 
 Druck P2 merken (z. B 2E-7) 
 Column fluten mit Stickstoff. Dafür das Programm: Tecnai TF20 Vacuum Control nehmen  

c:tecnai\exe\service\tstmdvakuum.exe 
 Blende losschrauben, vorsichtig rausziehen. Spezialschraubendreher liegt im Schrank ir-

gendwo 
 Handschuhe, Arbeitstisch mit Allufolie auslegen 
 Die jeweils 4 Blenden kann man vorsichtig eine nach dem anderen aus der Halterung ent-

nehmen. Dabei darauf achten, wie rum die waren (!!!) 
 Neue Blende und die anderen wieder einbauen mit einer Pinzette 
 Wieder in die Column rein, alles zudrehen 
 Im Vakuum-Programm alles evakuieren (einige Stunden, über Nacht), bis P2 wieder so 

wie vorher 
 Dann „Evakuate all“ im Programm drücken, so das normaler Vakuumzustand erreicht 

wird  
 Blende justieren (kleine Vergrößerung)    
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21. FEG-IGP-Ausheizen mit dem Heizband  

 
 

 

 

 

 

 

 

 

 

 

  

 

 

  

  
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Weitere Informationen 

22. Kontaktinformationen 

Leibniz Universität Hannover 
Laboratorium für Nano- und Quantenengineering 
Schneiderberg 39, 30167 Hannover, Germany 
Website: www.LNQE.uni-hannover.de  
Telefon Sekretariat:  +49 511 762 16017, Fax: +49 511 762 16099 
Gebäudenummer: 3430 

Geschäftsführer &     Technischer Leiter &  
TEM-Gerätebeauftragter:      Strahlenschutzbeauftragter: 
Dr. Fritz Schulze-Wischeler    Dipl. Ing. Oliver Kerker  
Telefon: +49 511 762 16014    Telefon: +49 511 762 16016  
Schulze-Wischeler@LNQE.uni-hannover.de   Oliver.Kerker@LNQE.uni-hannover.de   

LNQE-Notfallnummer: 0160 4327077 

E-Mailverteiler an alle TEM- Nutzer*innen: TEM-Nutzer@LNQE.uni-hannover.de  

23. Leistungsmerkmale des TEM 

Das TEM im LNQE hat eine Beschleunigungsspannung von 200 kV und als Elektronenemitter eine Feldef-

fektkathode. Wichtigste Paramater sind: 

 Gerätetyp: TEM Tecnai G2 F20 TMP von Fa. FEI 

 200 kV Feldeffekt FEG 

 Ölfreies Vakuum 

 TEM point resolution: 0,27 nm 

 Information limit: 0,14 nm (gemessen!) 

 STEM resolution: 0,24 nm 

 1 Hellfeld- und 2 Dunkelfeld-Detektoren +1 HAADF-Detektor 

 Tomografie ± 70°(Theoretisch bis zu ± 80° mit besonderen Halter)  
Mit diesem TEM sind alle klassischen Kontrastverfahren möglich: Hellfeld und Dunkelfeld, Beugungskon-
trast (einschließlich Weak-beam), parallele Beleuchtung bei alle Vergrößerungen (wichtig insbesondere bei 
der Untersuchung kristalliner Proben), TEM und STEM (scanning TEM). Dabei sind große Kippwinkel mög-
lich. Eine Besonderheit des TEM ist die Möglichkeit der Tomografie. 

 

24. Session buchen 

 Eine Session kostet 220 Euro.  

 Über folgende Adresse kann man sich im Online Web App (OWA) des LNQE einloggen: 
https://owa.lnqe.uni-hannover.de/owa/  
Dies ist eine sichere Verbindung. Ggf. muss man „Erweitert“ „Ausnahmen hinzufügen“ „bestätigen“ 
drücken.  

  Dort ist man am Anfang bei den E-Mails und muss in die Kalender wechseln (Links Oben) 

 

http://www.lnqe.uni-hannover.de/
mailto:Schulze-Wischeler@LNQE.uni-hannover.de
mailto:Oliver.Kerker@LNQE.uni-hannover.de
mailto:TEM-Nutzer@LNQE.uni-hannover.de
https://owa.lnqe.uni-hannover.de/owa/
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 In den Kalendern muss man einmalig den TEM-Kalender hinzufügen mit Rechtsklick auf „Kalender von 
Person“ auf der linken Seite-> „Kalender öffnen“ und dann eintragen „TEM Tecnai“ und mit OK bestä-
tigen.  

 Im TEM-Kalender kann man jetzt die gewünschte Session buchen.  

o Session 1: 8.30 – 13:00 Uhr 

o Session 2: 13:00 – 17:30 Uhr 

Doppelklick in das Feld mit dem gewünschten Tag und den neuen Termin eintragen. Bitte immer den 
eigenen Namen, die Bezeichnung des Instituts und den Namen des/der Professors/in, Gruppenlei-
ter/in etc. angeben, der/die die Rechnung für die Session erhalten wird.  

 

   

 

Eigener Namen, In-
stitutskürzel, Rech-
nungsempfänger

Zeitraum:   
Session 1: 8.30 – 13:00 Uhr 
Session 2: 13:00 – 17:30 Uhr 

Zum Schluss: Speichern und schließen 
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25. Auswertungssoftware 

 
 
Gatan Digital Micrograph  
 
https://www.gatan.com/installation-instructions  
 
 
ImageJ  

 
Mit der Free-Ware ImageJ lassen sich die dm3-Dateien von Digital Micrograph und die ser-Dateien von 
TIA  öffnen und bearbeiten. 
Installation:  

 ImageJ herunterladen von: http://imagej.nih.gov/ij/   (Meist der erste Treffer von Google für ImagJ) 

 Download -> Windows –> bundled with Java (neuste Version)  

 Das zip-File entpacken in einen Unterordner des eigenen Home-Verzeichnisses 

 Die Datei ImageJ.exe startet das Programm. Wer will, kann sich eine Verknüpfung von ImageJ.exe 
auf den Desktop erstellen.  

 Für TIA-Bilder (STEM) muss noch ein extra Plugin installiert werden: TIA_Reader.jar. Hier runterla-
den: http://rsbweb.nih.gov/ij/plugins/tia-reader.html und in den Ordner Plugins/Jars kopieren. In 
ImageJ: Dateien öffnen mit Plugins->Input-Output-> Tia Reader. Dort den *.ser File öffnen.  
 

Wichtige Funktionen: 

 Achtung: Wenn man was in den dm3-Dateien geändert hat, dann bleibt die Änderung drin (schlecht 
für eine weitere Nutzung). Deshalb entweder mit einer Kopie arbeiten oder nur Bilder mit „Save as“ 
speichern und das Original dm3 unverändert lassen.  

 Undo: Steuerung +z (nur ein Schritt zurück ist möglich)  

 Measure: Steuerung +m 

 Skale-Bar einblenden: Analyze -> tools -> Scale Bar 

 DM3 –Datei laden und dann das Bild mit File->Save as in einem anderen Format (z. B.) jpg abspei-
chern 

 FFT: Bild anklicken, Shift gedrückt halten und ein Rechteck aufziehen (des zu analysierenden Berei-
ches). Dann Process->FFT->FFT klicken für Fourier-Transformation.  Dann interessierenden Bereich 
auswählen (Rechteck), Image - > Crop. Dann: Analyze -> Set Scale und in „unith of length“  statt nm 
dann 1/nm reischreiben. Mit Analyze -> tools -> Scale Bar erhält man nun einen Scale Bar in 1/nm.   

 Eine Kurzanleitung gibt es auf: http://imagej.nih.gov/ij/docs/pdfs/ImageJ.pdf  

 Tutorials and Examples gibt es auf der ImageJ-Website: http://imagej.nih.gov/ij/docs/examples/in-
dex.html  

 
 
 
 
 
 

https://www.gatan.com/installation-instructions
http://imagej.nih.gov/ij/
http://rsbweb.nih.gov/ij/plugins/tia-reader.html
http://imagej.nih.gov/ij/docs/pdfs/ImageJ.pdf
http://imagej.nih.gov/ij/docs/examples/index.html
http://imagej.nih.gov/ij/docs/examples/index.html
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Wartungen 

Monatlich 

 Überprüfen der Drück von SF6 am Tank (Typisch 4,5 Bar, darf nie weniger als 4,0 Bar sein) und am TEM 
(etwas mehr als 6 Bar, siehe Markierung).  

 Überprüfen der Wasser-Durchflüsse, die zwischen den Markern sein sollten (auf 42 ml/h). Überprüfen, 
ob es Algenbildung gibt (dann ggf. Thermoclean nachfüllen) 

 Kühlwasser nachfüllen. (Normales Wasser) 

 Augendusche durchspülen  

 Blick auf die USV 

 Nach Wasserlecks gucken. 

 TEM abstauben, Trackball rausnehmen (gegen den Uhrzeigersinn drehen zum öffnen) und alles säu-
bern.  

 Bufferung des TEMs kontrollieren durch Gegendrücken.  

 Kleines Lichtmikroskope am TEM: Schrauben festziehen.   

 Selten (alle drei Monate): Probenhalter mit Isopropanol reinigen und Dichtringe fetten. 

 Gain & Dark-Reference der CCD- Kamera neu kalibrieren.  

 

Selten 

 1-2-mal im Jahr Thermoclean Blue 7 ml ins Kühlwasser geben. Wasser auffüllen.  

 Das große Zahnrad in der Compustage fetten (mit Molikote BR-2 plus) ca. alle vier Jahre. Altes Fett ab-
wischen und neues Fett drauf; wenig Fett. Nach dem Zusammenbau testen, ob sich die Compustage in 
alle Richtungen bewegen lässt. Am besten von Thermo/FEI machen lassen.    

 Alle zwei Jahre: Batterien für die Messung des Beam-Current wechseln. Ist nötig, wenn die Exposure 
Time falsch anzeigt.  
Dazu: 3 Schrauben am Tisch lösen, Tisch vorsichtig gerade nach vorne rausziehen. Kasten Links öffnen. 
Dann kommen 30 x LR44 Knopfzellen (1,5 V Alkaline) rein (Umbau von Oliver Kerker).  

 Am Ende des Jahres: Daten Sichern auf Backup-Platte.  

 Staubsaugen und ALLES abwischen 

 Kappe der Compustage reinigen 

 
 
 
 
 
 
 
 


